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Warranty Statement 

There are no warranties, express or implied, with respect to the contents of this document, and all information provided 
herein is provided “as is.” Osteoid reserves the right to periodically change the information that is contained in this 
document; however, Osteoid makes no commitment to provide any such changes in a timely manner or at all. 

Limitation of Liability 

In no event shall Osteoid or its affiliates be liable to any party for any direct, indirect, special, or consequential damages in 
connection with your use of this document, including, without limitation, loss of business revenue or earnings, lost data, 
damages caused by delays, lost profits, or a failure to realize expected savings, even if Osteoid was expressly advised of 
the possibility of such damages. 

End of Life Statement 

Osteoid is committed to the continuous improvement of InvivoLite by utilizing state-of-the-art technology and 
trends to provide the most comprehensive software for the diagnoses of patients. The “shelf life” of InvivoLite 
software has been defined as 3 years from the release to ensure the highest level of patient care and safety. 
Notification of software improvements and new releases will be provided to customers to update to the latest 
version. Previous (older) versions may continue to be utilized for diagnosis, but support may be limited.  

Trademarks 

Osteoid and related marks, images, and symbols are the exclusive properties of, and trademarks of, Osteoid Inc. All other 
brands and marks are the properties of their respective owners. 

Copyright 

Documentation for InvivoLite and the operating software are copyrighted with all rights reserved. Under the copyright 
laws, this documentation may not be reproduced, transmitted, transcribed, or translated into any human or computer 
language in whole or part without the prior written permission of the copyright holder. 

About Osteoid and InvivoLite Software 

This version of InvivoLite was released as an update to the original InvivoLite software from Anatomage, Inc. In 
this document, InvivoLite refers to the latest version of the Osteoid InvivoLite software and is synonymous with 
the terms “InVivoLight” and “InvivoLight.” To learn more about Osteoid, visit the Osteoid website 
(www.osteoidinc.com). 

Intended User 

InvivoLite is designed to be used by medical and dental professionals who have been appropriately trained to use 
3D CT imaging devices and read the image data generated by the devices. 
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Reporting of Serious Events 

If the use of this product resulted in, or may have contributed to, a death or a serious deterioration of health, this 
should be reported to the manufacturer at dental@osteoidinc.com  

Language 

The original language of this manual is English. Other versions are available. Please contact Osteoid for other 
language versions.  

Caution: Federal law restricts this device to sale by or on the order of medical and dental clinicians. 

Indications for Use 
InvivoLite is a software application used for the display and 3D visualization of medical image files from 
scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by radiologists, clinicians, referring 
physicians, and other qualified individuals to retrieve, process, render, review, store, print, assist in diagnosis and 
distribute images, utilizing standard PC hardware. Additionally, InvivoLite is a preoperative software application 
used for the simulation and evaluation of dental implants, orthodontic planning, and surgical treatments. 
 
This device is not indicated for mammography use. 
 
General Precautions 

  

  

 

Warning: The software provides tools for dental prosthetics creation and design but is dependent on the user to 
determine and use the appropriate parameters. Incorrect parameters may affect the quality of the final milled products 
or otherwise to surgical delays or complications. 

  

 

Warning: Please ensure all hardware devices with the software are password-protected from unauthorized use and all patient 
information is secure. 

mailto:dental@osteoidinc.com
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Introduction 
InvivoLite Imaging Software 

teoid, Inc. is a medical imaging company composed of a cross-
functional team consisting of the most elite researchers, 
mathematicians, engineers, software developers, business 
analysts, industry leaders, academic faculty, and dental 

specialists. We believe that InvivoLite software will enable the profession 
to initiate a revolution of unimaginable scope and magnitude. Ultimately, 
our mission is dedicated to developing simple and refined software 
specially designed for dentists to utilize the most advanced cutting-edge 
software and technology to better serve their patients. With InvivoLite 
software, doctors can create 3D volume renderings on their own 
computers, get cross sections, trace nerves, place implants, print images, 
save images, and many more functions. The software is designed to 
reconstruct these 3D volume renderings from DICOM files generated by CBCT, Medical CT, and MRI radiography 
machines. InvivoLite is intended for use as a planning and simulation software in the placement of dental implants, 
orthodontics, and surgical treatment. 

his manual is intended to provide supplementary information to your direct training with the Osteoid support team. 
For correct and safe use, training is available to all InvivoLite users and is highly recommended. In this document, 
InvivoLite refers to the latest version of the Osteoid InvivoLite software and is synonymous with the terms 
“InVivoLight” and “InvivoLight.” Previously released versions of this manual are available. For more information 

on how to access previous versions of the InvivoLite Reference Manual, please contact the Osteoid customer support team 
at (408) 333-3484 or email support@osteoidinc.com 

 

O 

T 

mailto:support@osteoidinc.com
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System Requirements 
Below are the minimal and recommended system configurations. 

aving an adequate computer system is essential to using InvivoLite efficiently and generating the highest quality 
images possible for enhanced analysis and presentation for your patients and colleagues. The most important 
element is the video card (3D graphics chip or GPU). If your system does not have an appropriate video card, 
you can purchase and install video cards for desktop computers. 

InvivoLite has minimal system requirements; however, Osteoid recommends the following configurations to fully utilize 
all the features within the InvivoLite Software. The following recommendations have been updated in September 2022: 

Summary 
 

Minimum Recommended 
CPU Intel Core i series Intel Core i7 (Gen8) or comparable multi-core 

processor 
RAM 8GB 16 GB 
GPU / Graphics Card Intel HD Graphics 515 (Gen9) AMD RX 5500 or comparable 
Hard Disk 100GB 500GB+ SSD 
OS Windows 7 64-bit Windows 11 64-bit 

 

Mac Users 

 OS Hardware 
Not Compatible Apple OS, Parallels MacBook Air, Mac Mini 

Fully Compatible Apple Bootcamp (requires a full license of 
Windows) iMac, MacBook Pro (15in), Mac Pro 

Note: For optimal visualization, the monitor display scale should not exceed 150 percent. 

Graphics Cards / GPU Details 

Brand Model Series Low-End Options High-End Options 

Intel HD Graphics 
Iris Graphics  

HD Graphics 
Iris Pro 

UHD Graphics 

Iris Plus, Iris Xe, Iris Xe Max Graphics  
AMD RX 5000/6000 Series RX 5000 – 5600  RX 5000 XT and 6000 XT series 

Nvidia Quadros 
GeForce  

GTX Series 
Quadro K and P Series RTX 3000 Series 

 

  

H 
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Installing Invivo 
About the License Types 
With the release of InvivoLite 7.0, a new licensing system was implemented providing more flexibility for users to use 
Invivo software on multiple devices, in addition to providing more traceability and security. Legacy licensing information 
can be found in our Knowledge Base, as well as their respective User Manuals. 

Invivo Workspace Account 
A free Invivo Workspace account is required to activate and manage your licenses. Invivo licenses are assigned to your 
user account using your email as your username. To create an account, visit www.invivoworkspace.com.  

Assigning a license (Invivo One plan) 
As an Admin, find your email username in the Organization list. In the Information Panel, assign yourself an Invivo One 
plan in the “Plan Level” section. InvivoLite is part of the Invivo One Standard plan. 

Note: Users who only have single person in their organization will have their plan automatically assigned to them. 

 

  

http://www.invivoworkspace.com/
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Assigning a license (Legacy Perpetual) 
For users who are migrating from the previous licensing system, as an admin, find your email username in the Organization 
list. In the Information Panel, toggle on the license you want associated with your account.  

 

Note: Users who only have single person in their organization will have their licenses automatically assigned to them. 

Licensing Support 
User can find knowledge base articles about licensing at the Osteoid help center: https://learn.osteoidinc.com  

Internet Requirement 
Internet is required when signing in or signing out of Invivo. During usage, if the computer loses connection to the internet, 
a 12-hour grace period starts. If the computer is not connected to the internet within that time, Invivo will be unavailable 
for use until the connection is restored. 

 
Website Installation Instructions 

1. Login into your Invivo Workspace account at www.invivoworkspace.com.  

2. Click on the My Products tab. 

3. Select the respective product (ie. InvivoLite, Invivo One Standard, etc.) 

4. In the Information Panel, click on the “Download” link 

5. Download the latest installer 

 
  

https://learn.osteoidinc.com/
http://www.invivoworkspace.com/
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Validating the Installer File 
 
1. Right-click the Installer file and select “Properties” to open the Properties window. 

2. Open the “Digital Signatures” Tab. 

3. Select “Anatomage, Inc.” and press Details. 

4. Verify that the Digital Signature Information is “OK.” 

 
The following pictures are for demonstration purposes only. The name of the installer and Digital Signature Information 
is dependent on the release version and may change accordingly.  

   
 
InvivoLite Setup Wizard 
 

Click Next to 
continue. 
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Installation Preferences: The user can specify the folder for software installation as well as the level of 
functionality with which the software initially opens.  

 
 
Review the End-User License Agreement and 
accept the terms if desired to proceed with the 
installation. 

 

 

Click Next to continue. The program proceeds with installation until completed. Click Finish to close the wizard. 
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Launching Invivo / Signing into Invivo 
Please be connected to the internet when starting Invivo. 

1. Launch Invivo 
2. During the Splash Screen, your internet browser will launch and be directed to the Invivo Workspace login 

page. 

a.  
 

b.  
 

3. Type in your login credentials. If you have not created an account yet, please follow the instructions to do 
so and launch Invivo again. 

4. After entering your credentials, a permission dialog will appear. 
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a.  
b. It is highly recommended to click “Always Allow” to improve launching Invivo in the future. 

Otherwise you’ll need to provide permissions every time you login. 
5. After clicking “Open Link”, Invivo will launch. 

 

a.  
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Feature List 
An overview of the various features provided by Invivo. 

• Directly Opens DICOM Data from Any CT Machine 
 

• Invivo File Compression 
 

• Section and Multislice View Operations 
 

• Volume Rendering of Scan Data 
 

• Linear, Angular, Circumferential, Area, and Volumetric Measurements* 
 

• Image Capture and Export 
 

• AVI (Movie) Capture and Export 
 

• Implant Treatment Planning 
 

• Restoration and Abutment Visualization 
 

• Bone Denstity Evaluation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*All measurements are performed with the metric system. 
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Software Layout 
The following is a description of how Invivo is organized by Menu Bar, Toolbar, View Tabs, View Control 
Panel, and Rendering Window. 

 

 

 

 

 

 

 

  
Control Panel 

The Control Panel is the region 
where patient images can be 

manipulated and controlled.  The 
Control Panel is associated with 

a specific View Tab. 
 

Rendering Window 
Rendering Window is the region 

where patient images are 
displayed.  This window can be 
customized within many of  the 

View Tabs by using the Toolbar. 

View Tabs 
The View Tabs 

perform specific tasks 
or look at specific 

subjects of  interest by 
adjusting the Toolbar 
and View Controls 

 

Menu Bar 
The Menu Bar 

contains application 
operations such as 
open, save, close, 
print, capture, etc. 

 

Toolbar 
Tools can be accessed to 

perform certain functions on 
patient images.  Sets of  tools are 
associated with a specific View 

Tab. 
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InvivoLite Preferences 
This section explains the different options within the Preference window of InvivoLite. The InvivoLite 
preferences include options for Display settings, Volume Rendering settings, as well as File Manager 
settings. 

Accessing the Invivo Preferences: 
• In the Menu bar of the Invivo, select “File.” 
• Select “Preferences…” from the “File” drop-down. 

 
Display Preferences 

 

GUI Settings 
• Background: Sets the background color for the 

rendering window. 
• Measurement Font Size: Sets the measurement 

font size to a size preset: small, medium, or 
large. 

• Measurement Text Color: Sets the text color for 
measurement notations. 

• Measurement Line Width: Sets the width for 
measurements. 

• Measurement Line Color: Sets the color of the 
measurement lines. 

• Tag Text: Provides an additional label to the 
right-hand corner of the rendering window. 

• Date Format: Current date format for case 
information display. 

• Continuous view: 
o Checked – Switching between view 

presets for volume renderings shows 
intermediate volume positions.  

o Unchecked – Switching between view 
presets does not show intermediate 
positions; the volume “jumps” to the 
final position. 

 
• Make text annotations global: When checked, previously placed or new text annotations added to any 2D 

slice view except group slices (TMJ, ArchSection) are visible when scrolling past the slice the measurement 
was placed on. 

• Cycle 2D distance measurement color: Measurement colors cycle with every measurement that is added. 
• Enable multiple distance measurement mode: Distance measurement becomes a toggle on/off button for 

measurement mode. Toggling “on” this mode continuously picks beginning and end points for linear 
measurements with each click after the first measurement has been created until toggled “off.” 

• Enable restricted access mode: This option is only available when running the software as an admin. 
Toggling “on” this option restricts the standard user from modifying software display preferences. 

Color Theme:  
• Two color themes are available for the software.  
• The software images in this manual are in Black and White mode, but the overall functions are shared 

between the themes. 
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Auto save 2D view setting on application exit 
• This setting determines if 2D view settings made in each of the applicable tabs are saved automatically 

upon program closure and be reloaded with the next opened case. If left unselected, the user has to 
manually save the configuration by clicking Save View Settings in the working tab. The specific 2D view 
settings that are saved in each tab are given in the table below: 

 
ArchSection Slice Interval, Cross Section 

Width/Interval/Thickness, Auto R-L, Pano Image 
Type, Pano Ruler Enabled, Brightness/Contrast 
mode, Layout (including Axial vs. Cross Series and 
Print Layout), Sharpen Filter, Color Preset, Nerve 
Diameter, and Nerve Visibility 
 

Implant Planning Layout, Restoration Lock, View Preset, 
Brightness/Contrast, Sharpen Filter, Volume 
Clipping, and Remove Crown 
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Volume Rendering Preferences 

 

Volume Rendering View Settings 
• Quality Resolution: Sets the limit for the 

resolution of the image. This can be set to either 
a user-defined number or set to Unlimited. 

• Initial Rendering: Sets the rendering quality 
upon opening Invivo. 

• Shaded Slice Sampling Rate: Accepts a 
numerical value that sets the sampling rate to 
improve image quality at the cost of 
performance. 

• Use lower resolution while moving volume: 
Positional changes of the volume are rendered at 
a low-quality resolution while maintaining the 
quality resolution setting in the final position. 

Volume Rendering Range 
• The user can define the range of Hounsfield 

Units that are rendered. This cannot be set when 
“Use automatic H.U. range” is checked.  

• Checking “Non-CT modality: use scalar for 
min-max” allows the user to define the 
minimum and maximum scalar units that are 
rendered. 

Material 
• Various properties can be adjusted to change the appearance of a volume rendering. Ambient, Diffuse, and 

Specular effects can be rendered in different colors. 
• The degree of Emission and Diffuse can be adjusted with the respective sliders. 
• Shininess is set to a number – higher numbers denote less shininess. 
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File Manager Settings 

File Type-Associated Folder Paths 
Folder paths can be set for each of the Invivo and DICOM file type options. When one mode is selected, the program 
uses the file paths associated with that file type mode, but the user may still save or open either file type at any time. 
 
File Path Preferences for Different Users 
In the situation that there are multiple users on a single computer with Invivo7 installed across multiple user 
accounts, the file paths for all new accounts initially take on the preferences defined by the user administrator 
account. Non-admin accounts may redefine their file path settings, but they will be overwritten the next time the 
settings are changed on a user administrator account. 
 

   

File Paths 
• Admin Only: Toggling “on” this option restricts 

the standard user from modifying software 
display preferences. 

o This option is only available when 
running the software as an admin. 

• Osteoid Case Path: This folder serves as a 
backup folder for all opened cases from the 
locations selected in the Copy Files to Osteoid 
Case Folder Before Open. 

• Default Open Path: This is the starting location 
for attempting to open a case through File → 
Open in the Menu bar. 

• Default Save Path: This is the starting location 
for saving a case file in Invivo. 

• Temporary File Path: This is the temporary 
location that the Capture To File In Temporary 
Folder function uses. 

Copy Files to Osteoid Case Folder Before Open 
• This section allows the user to save a copy of a 

case that is to be opened in the Osteoid Case 
Folder if it is in any location besides this folder, 
such as on a different location on a network, on 
a CD-ROM, or in a different folder on the local 
hard drive. 

DICOM Advanced Settings: Change Character Set 
• This option is only available if the DICOM File option is selected. 
• Import 

• If checked, this sets the value for the Specific Character Set DICOM tag (0008, 0005) 
o When Missing: This will use the specified value only when the tags are missing 
o Always: This will always use the specified value on import 

• Export 
• If checked, this sets the value for the Specific Character Set DICOM tag (0008, 0005) on export. 

   Warning: Importing or Exporting with the incorrect Character Set could lead to unreadable text.  
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Basic Features 
The following is a detailed explanation of the various features provided by Invivo. 

DICOM & Invivo File Loading with the File Manager 
  
To open a DICOM data set or Invivo-associated file type (.inv, .amg, apj), first launch the Invivo software. The File 
Manager appears upon startup for loading the scan data. If one of the PACS mode options in Preferences was 
selected, please refer to page 24. 
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Click the Browse File from This Device 
button to search manually for local data 
to open. For opening DICOM data, as 
shown to the right, simply highlight one 
of the .dcm files and click Open. It does 
not matter which DICOM file is 
chosen, as selecting one opens all the 
files within the data set present in that 
folder. For opening an Invivo file, select 
it and press Open. Invivo files can also be 
compressed and opened. 
 

 
The File Manager automatically stores recently viewed case locations. This allows for quicker access to these 
cases. By default, files are saved in the “Osteoid Cases” folder, located in “My Documents.” This location can 
be changed in the Menu Bar → File → Preferences → File Manager. 
 
Quickly search through the recent cases 
by typing in the Patient Name or Scan 
Date in the search fields (shown right). 
The selected cases can be removed from 
the Recent Case List by selecting the 
Options... button and using the additional 
buttons (shown below). These options 
can completely clear the Recent Cases 
list. 
 

 

Click the Browse File from The Invivo 
Workspace button to search cases 
available on Invivo Workspace. Available 
cases are displayed in the File Manager to 
be loaded into Invivo. Files are nested 
under the Case ID. 

 
 
After closing a case, to reopen another one, click on “File” → “Open”, and the File Manager will appear again. 
 
Selecting Options… displays additional options to delete the recent case history or to delete select cases from 
the list. This only modifies the cases that are displayed on the File Manager and does not delete the actual files 
from where they are saved. 
 

 

 



 
 

     23 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

Invivo/DICOM File Saving 

Invivo provides four options for saving and each type differs in the 
size of the saved file and its compatibility with other software. 
Choosing “File” → “Save As...” for any file presents the dialog on 
the right. Choosing “File” → “Save” when a DCM file is open 
saves an INV in the specified location or simply overwrites the 
same file if it is already in INV file type.  

 
Invivo 
The following work can be saved as an Invivo file 
(.inv).  

• Case Information & Patient Orientation 
• Traced Nerves 
• Implants & Implant Measurements 
• Volume Measurements, Landmarks, and 

Annotations 
• Images captured within the Gallery 

 

 
Click “File” → “Save As...,” browse to the 
destination folder, name the file (default is the 
patient’s name), then click Save. 
 
The following save dialog box appears. Select the 
default “Full” option for saving everything without 
losing any information. 
 

 
DICOM  
When the DICOM file type is chosen, the output 
options are either a single lossless DICOM or a multi-
file DICOM (with DICOMDIR) accompanied with 
an Invivo workup file containing workup data and a 
folder of exported Gallery images in DCM format.  
 
For single-file DICOMs (Figure 1), the save dialog 
asks for a location to save the files. For multi-file 
DICOMs (Figure 2), create or choose a folder to save 
the slices and DICOMDIR file. The DICOMDIR file 
presents the directory of slices to Invivo to accelerate 
the loading speed. 
 

 
Figure 1: Single-file DICOM Save Dialog 

The DICOM File Save Option dialog (Figure 3) presents numerous options for saving the file. Compression 
reduces the size of the file at the cost of increased saving and loading speed. “Lossless” or “Lossy” determines 
the quality (amount of data) of the file that is saved. Resampling changes the resolution by a factor in each 
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orthogonal plane. The workup file description can be used to differentiate between different workup files on 
PACS. If “Save additional series” option is selected, the coronal and sagittal DICOM series are also exported 
along with the default axial series. 
 

 
Figure 2: Multi-file DICOM Save Dialog 

 

 
Figure 3: DICOM File Save Options 

Custom Saving Dialog 

Available for Invivo file saving: By selecting the “Customize” option, 
the custom saving dialog shows up. In the dialog box are data 
compression options. For the main volumetric image, “Lossless” or 
“Lossy” compression options are available. With lossless compression, 
the volume is compressed to about 1/3rd – 1/4th of the original size. With 
the Lossy compression option, the file size can be dramatically reduced, 
but the image is altered. Resampling the data greatly reduces its size by 
combining voxels to reduce the overall voxel count. Rescaling the image 
reduces the number of shades of gray in the image. Options to selectively 
compress images in the Gallery, the clinical content (such as implants 
and nerve tracings), and the models can be selected.  

 

 
Warning: Saving files in lossy format degrades image quality. 

 
Saving As an Invivo Project File 

Click “File” → “Save As Project...” to save the case as an APJ, Invivo Project file. This file only saves work up data. It 
requires a reference data (.dcm scan data or .inv file) when opening. If Invivo cannot locate the reference data, it prompts 
to locate the data filepath. Because it is saving only the changes to the original, APJ files save much faster than full INV 
files. 

Export DICOM & Viewer/Lay Egg 

This function creates an executable file containing the 3D volume data from the scan that is currently open as well as a 2D 
Invivo viewer program. This function is designed to allow the sharing of scan data from an Invivo user to a non-Invivo 
user on shareable media such as a CD, DVD, or flash drive. Note that some antivirus programs may detect the file as a 
virus due to its executable format. 
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EggViewer: Running this file initializes 
the viewer program and then loads the 
embedded scan data. The EggViewer 
contains some Section, ArchSection, and 
Gallery functionality.  

                

Export to CD 

This function exports the currently opened scan as a compressed or uncompressed DICOM or a full, compressed, or 
customized setting Invivo file. The exported file is placed in the temporary burn location in the computer.  
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Send File 
Invivo Workspace 
The active case can be sent through Invivo Workspace as 
an Invivo, single file DICOM, multi-file DICOM with 
DICOMDIR, or multi-file DICOM with .dcm extension 
file types. The software prompts the user to sign in to an 
Osteoid Cloud account if not already logged in. 

 

After logging in, the user can input the recipient’s name, 
email, message subject, and discussion notes. Existing 
contacts in Invivo Workspace can be searched to 
automatically populate the contact. The case and message are 
sent to the recipient’s Invivo Workspace account. The 
recipient can then preview the case through the browser 
viewer or download it for further use.  
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Upload for Service 

To send the case directly to the Invivo Model website for the 
Invivo Model service, input the Invivo Model login when 
prompted. Toggle on “Remember Me” to retain the login 
information, and click Upload to upload the case. If further 
instructions are required for processing the case, please contact 
the Invivo Model department at 408-333-3484 ext. 5.  

Note: This function cannot be used for uploading Surgical Guide 
cases. To do so, please access the Invivo Model website 
(invivoservice.com). 
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Case Information Display 

To display or hide the Case Information for a specific patient, go to the “File” → “Case Info.” Click Anonymize then click 
OK to save the changes. 

   

Manage Workflow 

To edit the naming, order, and number of tabs that load with the software, go to the “File” → “Manage Workflow.” 

To rename a tab, click on it in the Name column in the My Workflow window, and type directly into the field. To change 
the order of tabs, click on the tab and select “Move Up” or “Move Down.”  

To add or remove tabs, select them from the Source Views window or the My Workflow window and select the button to 
add or remove respectively. 

The software must be relaunched to apply the workflow changes. 

Image Capture to File 

To capture an image of the active display to file, click “View” → “Capture to File.” Browse to the location to save the 
image, type the name of the file, choose the file type on the “Save as type” drop-down, and click Save. The file can be 
saved as bmp, jpg, or png format. Jpg is the most popular file format for images, but there is a small amount of color 
degradation. Bmp preserves the image, but the file size is big. Png is an effective lossless format that does not degrade the 
color. 
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Image Capture to Gallery 

Selecting “Capture To Gallery” or pressing Ctrl + G captures an image of the rendering window and saves it to the Image 
List (see Gallery Tab features for additional information, pg. 58).  

 

Image Capture to Clipboard 

Selecting “Capture To Clipboard” captures an image of the rendering window to the clipboard for pasting in other programs 
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Image Navigation 
Below is an explanation showing how to manipulate images in the rendering window with the keyboard 
and mouse. 
 
Slider Scroll 

 
• Click the mouse cursor over any slider (e.g. axial slice, brightness, etc.) and move it to adjust the image. 
• Click the slider and keep the mouse cursor in the Control Panel before scrolling the mouse wheel forward or 

backward to achieve the image adjustment you like. 
 
 
Zoom In/Out  

• Place the mouse cursor in the center of the image. 
• Hold down the “Control” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse up 

and down on the screen. 
• This shrinks/enlarges the image: Down vertically zooms out. Up 

vertically zooms in. 

 

Pan (Shift) 

• Place the mouse cursor in the center of the image. 
• Hold down the “Shift” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse any direction to 

achieve the desired image displacement. 
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Free Rotate 

Applicable only for 3D images.  
 
• Place the mouse cursor in the center of the image.  
• Hold down the left-button on the mouse. 
• While holding down the left-button, move the mouse in any direction to 

achieve the desired rotational position. 
 

 

Free Rolling 

Applicable only for 3D images.     
 

• Hold down the “Space” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse up and 

down to rotate the image about a central axis. 
 

 

Increment Rotate 

Applicable only for 3D images.     
 
• Use the keyboard arrows ← ↑ ↓ → to rotate the 3D Model 1 degree up, down, right, or left, perpendicular to the 

computer screen. 
 

Increment Roll 

Applicable only for 3D images.     
 
• Hold down the “Control” key and use the keyboard arrows ← → to rotate the 3D Model 1 degree rolling left or 

right about a central axis. Pressing ← →  without the Control key pressed rolls the image left or right. Use ↑ ↓ to 
roll the image up or down.  
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Anatomical Plane Clipping 

Applicable only for 3D images.  
 
• Enable clipping in the Control Panel. 
• Place the mouse cursor over the center of the image, then scroll the 

mouse wheel forward or backward to clip the anatomic plane as 
desired. 

 
 
 
 
 
 
Scroll Slice 

• For 2D views, place the mouse cursor in the center of the image then scroll the 
mouse wheel forward or backward to move one slice at a time. 
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Full Screen Mode 
Below is an explanation pertaining to running the software in full screen mode. 

Switching to Full Screen Mode 

From the software menu, select “View” → “Full Screen.” “Full screen stereo” is only applicable for the stereo display 
system. To return to the normal screen mode, press the “Esc” key on the keyboard.  
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The View Tabs: 
 
\ArchSection View Features 
ArchSection View Tab is a sectional image exploration view. Instead of conventional X-Y-Z sections, this 
view allows the user to review the image in dentally meaningful perspectives using multiple cross sections, 
traversing the lengths of the dental arches. 

 



 
 

     35 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

ArchSection: Toolbar 

Shown below are the Toolbar and tools that are loaded with the ArchSection Tab: 

  

 
Reset: Resets the window to the original view. 

 

Create Arch Spline: After selecting this tool, create a new arch spline or edit an existing arch spline. Left-
click to place nodes along the arch. Right-click or double-click to finish the arch spline. To modify an 
existing arch spline, drag the nodes to the desired positions. To move the arch while maintaining its shape, 
click and drag the central spline.  

 
Arch Spline Ruler: Places ruler along the arch spline for easy reference. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A number 
in millimeters automatically displays. 

 

Angle Measurement: Select this option and mark three points on the volume, and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of the desired area. 
Double-click or right-click to end the measurement. A number in millimeters squared  automatically 
displays. Click on the measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of points in the slice view. Right-click to 
end the measurement, and the total distance appears.  Clicking on the nodes and moving the cursor can 
modify points. Click on the measurement and press the “delete” key to delete it. 

 
Reorientation: Adjusts the patient orientation and the visible range of the scan. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of an area within a bounding rectangle, circle, or ellipse. The 
measurements display alongside the shape and can also be repositioned by dragging. The information 
updates when the box is moved or if the user scrolls. 

 

Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of slices or groups of 
slices from a series of cross sections. Requires the creation of a slice group in the Report Tab and an 
activated Report module. 

 
Rotate Cross Section: Adjusts the patient orientation in the cross sections. 

 

Layout: After clicking on the layout icon, a list of various layout options appear. Click on the 
desired layout to apply it. A custom layout can be created and loaded. 

 
Toggle Cursor Visibility: Conceals or displays cursors. 

 
Information Display: Displays or hides case information embedded in the data. 

 

View Sequence: Allows for the creation of custom camera sequences and AVI file movie capturing. 
Refer to the Volume Render View Sequence (pg. 34) section for additional information and 
description. 
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Warning: Any measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of the image. Software reports the value based on user-picked points. Due to the nature of medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of the measurement value before applying to the patient. If you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@Osteoid.com 

 
 

mailto:info@anatomage.com
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ArchSection: Control Panel 

 

Layout: 
• Change Layout adjusts the layout with different numbers 

of slices and orientations. A custom layout can be 
configured. (See page 41.) 

• Maxillary Arch and Mandibular Arch options allow two 
different arch splines to be created and saved. Switching 
between the two options changes which spline is 
manipulated and used in creating the panoramic and cross 
sections. 

• “Print Out” layout is optimized for printing the image on 
paper. With Print Out layout, the current view can be printed 
on the paper in life-size. First, capture to Gallery, then print 
from Gallery to ensure the image is life size. 

Axial Section: 
• Interval: Distance between the subsequent axial sections. 

Cross Section: 
• Width: Cross-section width. 
• Interval: Distance between the subsequent cross sections. 
• Thickness: Allows for the cumulative thickness of the slices 

to be viewed in the cross sections. 
• Auto R-L: This allows the cross section to be oriented to a 

consistent R-L orientation on the screen. If turned off, the 
cross-section orientation is consistent to the arch spline. 

Panoramic Image: 
• Slice mode displays a single cross section along the panoramic curve (yellow). This mode is used for tracing 

the nerve. 
• X-ray shows the ray sum (reconstructed x-ray) in the focal trough. 
• Ruler: Displays a ruler on the bottom of the panoramic image. 

View Control: 
• Brightness and Contrast can be used to adjust the image. 
• The All drop-down allows for brightness/contrast adjustments in different areas independently. 
• Different Color Presets can be used to view the images in color. 
• Sharpening Filter applies the selected sharpening filter from the drop-down menu to the 2D slice renderers. 

Nerve Pathway: 
• New Nerve: Starts a new nerve tracing. 
• Modify: Allows editing of the selected nerve tracing. 
• Visibility: Controls the visibility of the nerve in the section and X-ray renderers. 
• Nerve Node: Select a specific node for modification. 

 
• Diameter: Selects the diameter of the nerve that has been traced or a specifically selected node. 
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• Delete: Deletes the last placed node during the tracing or the entire nerve if Modify is active. 
 
 Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences section 

in Preferences (pg. 17) for more information on which settings are saved for this specific tab.  
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ArchSection: Rendering Window 

 
 
Arch Cursor: Notice the green, orange, and brown coordinate indicators. These ArchSection coordinate indicators show 
the spatial location within the ArchSection modeling window. 
• Cross Section Indicator: The green lines give the location of the cross sections along the arch spline.  
• Axial Slice Indicator: The orange line shows the axial coordinate position within the section.  
• Arch Spline: The brown spline in the center of the arch spline represents the current position where the arch section 

has moved. 
• Cross Section: Mouse scrolling within any one of the three sagittal frames advances the slices to the patient’s right or 

left and causes the green coordinate indicator to move anteriorly or posteriorly in the axial and pano sections 
simultaneously. The up and down keys can also be used to scroll through cross sections by page. 

• Axial Section: Mouse scrolling within the axial section advances the sections superiorly or inferiorly and causes the 
red coordinate indicator to move superiorly or inferiorly in the cross or pano sections simultaneously. 

• Pano Section: Mouse scrolling within the coronal frame advances the slices buccally or lingually and causes the 
brown coordinate indicator to move buccally or lingually in the axial and cross sections simultaneously.                               
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ArchSection: Creating A Nerve Pathway 

Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 
• Click New Nerve. 
• Left-click the mouse to start the nerve. 
• Move the mouse to the next point along the nerve path and left-click again. 
• Click Delete to remove the last-placed node if it is mispositioned. 
• Repeat this procedure for the entire length of the nerve. 
• 2.0 mm is the default diameter of the nerve pathway, but the parameter can be adjusted as desired. 
• Press Done to finish. 

 
Editing a Nerve Pathway 
• Click on a nerve tracing to select it. This highlights the nerve in a brighter red color. 
• Click Modify. This reveals all of the nerve nodes that are visible in each slice in blue. 
• Nodes can be moved by clicking and dragging it across the scan. 
• Set the Nerve Node drop-down menu to “All” or a specific node.  
• If “All” is selected, the entire nerve tracing’s diameter can be adjusted. 
• If a single node is selected, it is located in the slices, and its diameter and position may be adjusted independently. The 

nerve node diameter is adjusted in the Diameter drop-down menu.  
 
Deleting a Nerve Pathway 
• The Delete button can be used if a point was plotted in the wrong spot by deleting the last point added. 
• Once a nerve has been completed and Done has been clicked, the nerve can be deleted by clicking on it and pressing 

the “delete” key on the keyboard or the Delete button. 
 

 
 
  

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if diagnosis, treatment plans and/or actual treatment is based off of the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If you notice any inconsistencies or software problems with 
nerve tracing or have further questions or concerns about nerve tracing, please contact Osteoid support at (408) 333-3484 or 
email us at info@Osteoid.com 

mailto:info@anatomage.com
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ArchSection: Custom Layouts 

A custom layout can be set by going to the Layout tool or Change Layout. Click Set Custom Layout. 

 

Step 1.  

Select whether the axial slice or the panoramic image should be visible. Set the number of columns and rows of cross 
sections. At least one cross section is always visible. 

Step 2.  

Select whether the main rendering window division is horizontal or vertical. 

Step 3.  

Click and drag the grey dividing borders to adjust the boundaries of each view. This affects the resulting size of 
each view. 

Once OK is clicked, the custom layout is applied. If another layout is chosen subsequently, the custom layout can 
be reloaded by going to the Layout tool or Change Layout and clicking Load Custom Layout.  
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Implant View Features
The Implant View Tab contains the full-featured implant planning module. 
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Implant: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Implant View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume and distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the 
“delete” key to delete it. Control Panel features in Volume Render Tab allow the values to be projected to 
2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between 
them appears. Clicking on their control points and moving the cursor can modify measurements. Click on 
the measurement and press the “delete” key to delete it. Control Panel features in Volume Render Tab 
allow the values to be projected to 2D, hidden, or exported to a report. 

 
Text Notation: Allows text to be written and edited on the image. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label and press 
OK. 

 

Add Implant: Select the Tooth ID for the implant, mouse over the implant site, and left-click the mouse 
to place the implant. Note: specific manufacturers measure the implant from different points, so a 
measurement in the software might not be the same as the actual measurement of the specific implant 
design. 

 
Toggle Move Widget: Toggles the implant orientation widget on and off. 

 
Implant Angle Dialog: Opens a window displaying all the angles between placed implants. If an angle is 
clicked, the volume is rotated to view the angle, and the relevant implants are highlighted. 

 
Density Profile Control: Adjust the settings for the displayed density profile around planned implants. 

 
Treatment Lock: Locks the implants in place so that they are not accidentally moved when viewing the 
3D images. 

 
Check Sleeves: The program searches for collisions between the sleeves, instruments, and stone models. 

 
Bone Graft: Simulates a bone graft near the apex of an implant and displays its volume. 
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Change Model Visibility: Allows various models to be turned on or off from view. 

 

Create Summary: Creates an Implant summary of images that is added to the Gallery. Images contain 
ID (FDI), implant product, diameter, and length information in the lower right-hand corner of the 
screenshot. The user is also given an option to print a reference chart which lists the implants placed 
(including implant site, manufacturer, product name, diameter and radius) for each arch. 

 
Layout: Toggles the rendering window layout. 

 
Grid: Toggles between two different grid layouts for use in the upper two section frames allowing quick 
assessment of measurements and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 
View Sequence: Opens a dialog that provides view sequence presets to create a video. 

 
Settings: Adjust the tooth system type, clipping preferences, collision and surrounding parameters, 
rendering quality object colors, and implant library settings. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of the image. Software reports the value based on user-picked points. Due to the nature of medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of the measurement value before applying to the patient. If you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@Osteoid.com 

 

Warning: Any implants and restorations that are incorrectly visualized in Restoration Design Studio may lead to surgical 
complications or treatment delays. If you notice any inconsistencies or software problems with implant or restoration planning 
or have further questions or concerns, please contact Osteoid support at (408) 333-3484 or email us at info@Osteoid.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If you notice any inconsistencies or software problems with implant planning or 
have further questions or concerns about correct utilization of implant planning, please contact Osteoid support at (408) 333-
3484 or email us at info@Osteoid.com 

 

 

mailto:info@anatomage.com
mailto:info@anatomage.com


 
 

     45 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

Implant: Control Panel 

 

Add Implant: 
• Select one or more implants for placement. 
• Maxillary and mandibular parallelism can be enabled. 
• Place each implant in in the 3D volume. 
• Adjust the implant orientation and placement using the move 

widget that appears on the selected implant. 
Planning Layout: 

• 3D Implant: Place and adjust individual implants on 3D 
volume and 2D slices. 

• Pano Implant: Click and drag implants into the panoramic 
image. Selective parallelism can be configured in this view.  

Restoration: 
• Add All: Adds default restorations to all the implants. 
• Remove All: Removes all restorations. 
• Edit: Transfers the current progress to the Restoration Tab for 

advanced crown placement and design. See the Implant: 
Advanced Restoration Design section (pg. 53) for more 
information. 

• Lock to Implant: When selected, the implant and restoration 
move as a single unit. 

View Presets: 
• Setup: Opens a dialog where the view presets can be 

configured. 
• Presets: Preset toggles that display the selected features as 

configured in the Setup. 
Upper/Lower: Toggles the visibility of the stone models if 
present. 

View Control: 
• Rendering Types: Different settings allow for better visualization of certain anatomic structures, soft 

tissue profiles, hard tissue, etc. This is achieved by displaying specific densities with specific colors. 
• Brightness & Contrast: Can be adjusted for each of the presets to enhance the image. 
• Visible: Allows the 3D Volume Rendering to be turned on or off from view. 
• Remove Crown: Only applicable with surgical guide-related modeling service options. 
• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D slice 

renderers. 
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Clipping: 

Click the “Enable Clipping” box to slice the image along the predefined anatomical planes (sagittal, axial, coronal, 
and arch). Scrolling the mouse wheel or moving the slider moves the clipping plane. To switch a view to the opposite 
side, click “Flip.” 

Implant: 

The implant section can be configured to only show specific implants as defined by the user. For more information, 
look at the Preferred Implant settings further in this section. 
• ID: Use the drop-down menu to select an implant to manipulate. The active implant appears lighter in color 

than the others. 
• Manufacturer, Product Name, Diameter, and Length: The default is generic, but the specific implant 

manufacturer, product, diameter, and length can be selected. 

Save View Settings 

Saves the current 2D view settings to be reloaded upon opening any case. See the Display Preferences section in 
Preferences (pg. 17) for more information on which settings are saved for this specific tab.  
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Implant: Rendering Window 

 
Used for more precise control and final detailed touches to implant treatment planning. Use the navigation features 
discussed below to visualize all aspects of the implant in the 3D volume. For further information on implant position and 
sizing using the implant widgets, please refer to the next section of the manual.  

Axial Section: Top left window. This section is the view from the top of the implant. The yellow line passing through 
the axis creates the view seen in the sagittal view. Scrolling the mouse wheel after clicking inside the axial window, or 
clicking and dragging the line changes the cross section seen in the sagittal view as the line rotates about the axis of the 
implant. Asymmetrical (STL) implants can be rotated about the long axis in this view (see the next section). 

2D Section: Middle left window. The A-B line passing through the implant creates the cross-section view that appears 
in the axial view and is set by default to be positioned at the level of the implant emergence point. Scrolling the mouse 
wheel after clicking inside the sagittal window, or clicking and dragging the line changes the cross section seen in the 
axial view. The implant widget in this view allows for quick resizing of implant length and diameter (see the next section). 

Density Profile: Lower left window when turned on. Displays a real-time visualization of the volume density 
immediately surrounding the implant. 

Volume Rendering: Right window. This frame allows user to change the implant position and orientation with the 
orientation widget within the 3D volume rendering. 

 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If you notice any inconsistencies or software problems with implant planning or 
have further questions or concerns about correct utilization of implant planning, please contact Osteoid support at (408) 333-
3484 or email us at info@Osteoid.com 

Implant: View Preset Setup 

Visibility presets allow for easy switching between set views during implant planning. To configure these settings, click 
on Setup. These presets may also be modified in the Restoration Tab. 

mailto:info@anatomage.com
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• Edit Name: Click on any preset to select it. Type the new 
name into the field. 

• Visibility checkboxes hide or show features in the 
rendering window. 

• Implant Profile: Controls the visibility of the solid 
implant cross section in the 2D renderers. When activated, 
the currently selected implant has a red profile and the 
unselected implants have blue profiles. When not 
activated, the selected implant shows an opaque cross 
section of the implant, and the unselected implants show 
as blue profiles. 

• Abutment: Controls the visibility of the abutment 3D model in the volume renderer or the colored profile in 
the 2D slice renderers. 

• Waxup: Controls the visibility of the profiles in the 2D renderers and 3D models on the volume. Option is only 
available after they have been added by an Osteoid technician as part of a surgical guide case workup.  

• Long Axis: Displays a colored rod running through the long axis of the implant in the volume render. 
• Surrounding: Displays the surrounding volume around an implant. The collision zone is determined by the 

allowance defined in the preferences. 
• Trajectory: Displays the simulated trajectory of the implant during surgical placement. 
• Sleeve: Controls the visibility of the profiles in the 2D renderers and 3D models on the volume. Option is only 

available if the mandibular and maxillary models are available as well as after the Check Sleeve action has been 
performed.  

• Nerve: Displays a 3D nerve in the volume render or a cross section of the nerve in the 2D section renderers. 
• Angle: Controls the visibility of the angle between the long axes of adjacent implants as well as the angles of 

the abutment for each implant. 
• Model: Controls the visibility of the stone models. Varying degrees of transparency can be obtained with the 

Opacity slider. 
• Restoration: Controls the visibility of the 3D waxup models in the volume renderer and the colored profile in 

the 2D section renderer. The colored profile of the selected restoration or restoration associated with the selected 
implant is red while the unselected restorations are pink. Varying degrees of transparency can be obtained with 
the Opacity slider. 

• Volume: Controls the visibility of the volume render as well as the rendering type. 
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Implant: Model Visibility 

The   Change Model Visibility function opens the Model Object Settings 
dialog.  

• The “Mandible” and “Maxilla” checkboxes control all of the model 
visibility options (except Profile Only and Density) and allow the user to 
turn off the set of models for each jaw independently.  
Note: The visibility checkboxes in Model Object Settings do not always 
match the checked/unchecked status of the visibility checkboxes in the 
Control Panel. 

• The Stone Model and Waxup Opacities can be adjusted for both jaws. 
• The Sinus Graft option toggles the visibility of the bone grafts present in 

the case. 
 

Implant: 3D Implant Widget 

The  3D implant widget is designed to optimize visibility in the renderer and 
provide a high level of versatility in implant positioning. The linear, colored arrows 
can be dragged to reposition the implant transversely. These arrows only appear 
when the camera perspective is close to orthogonal. The implant may also be 
moved along these directions using the keyboard arrow keys. 

• The yellow arrow (not shown) is parallel to the A-B line. 
• The blue arrow is orthogonal to the green and yellow arrows. 
• The green arrow runs through the long axis of the implant. 
• The rotation circle appears on the same plane as the two arrows that are close 

to orthogonal to each other and to the camera perspective and features eight 
handles for rotation.  

Implant: 2D Implant Widget 

The 2D implant widget is designed to optimize visibility in the slice renderer and 
provide a high level of versatility in implant positioning and sizing. The implant 
may also be moved along its long axis or orthogonally with the keyboard arrow 
keys. 

• The rotation circle has eight arrows for implant rotation along the same plane 
as the currently displayed slice. 

• The two red handles can be selected and dragged toward/away from the 
implant to reduce/expand the diameter of the implant sequentially through any 
available options for that implant model. 

• The two blue handles can be selected and dragged toward/away from the 
implant to reduce/expand the length of the implant sequentially through any 
available options for that implant model. 

• The implant model itself can be selected and dragged in any direction along 
the same plane as the currently displayed slice. 

• A rotation circle appears when the product cross section is selected that allows 
for implant rotation about the long axis of asymmetrical (STL) implants in the 
top left section renderer. Please contact Osteoid for an updated list of 
asymmetrical (STL) implants. 
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Implant: 3D Implant Planning 
 

• In the Control Panel, click the Add Implant button.                     
• The implant ID dialog shows up (image below). 
• Select the implants to be inserted. Press OK, and an implant and its ID appear on the mouse pointer. 
• Drag and drop each implant in 3D view onto the surgical site. (It helps to have the volume rotated so that the surgical 

site is centered.) 
• In axial view, align the yellow line such that the lower cross-section view becomes the view along mesiodistal 

direction. 
• In cross-section view, re-orient and position the implant so that its angle is as desired. 
• In axial view, align the yellow line such that the cross-section view becomes the view along the buccolingual direction. 
• In cross-section view, re-orient and position the implant so that its angle is as desired. 
• Review the final implant position in 3D view. 

o To delete an implant, select the desired implant in the 3D view and press the “delete” key on the keyboard. 
The implant is removed. 

 
A similar procedure can be done to add anchor pins to the 3D volume. Select which anchor, and follow similar steps for 
adjusting its position. 
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Implant: Pano Implant Planning 

 

• Select Planning Layout: Pano Implant under the 
Control Panel in the Implant Tab. 

• Rendering window updates to pano view (left). 
• Adjust the ArchSection focal trough such that the 

middle profile passes through the dentition.  
• Drag implants to their desired locations and adjust 

their angles. 
• Click to select implants and manipulate them in 

the cross sections. 

• Click the nodes above the implant identification numbers and drag to connect them with other implants to create 
parallel implant groups. Remove the implants from these groups by clicking on the nodes again. 

• Repeat for all desired implants. 
• Select Planning Layout: 3D Implant to exit Pano-Mode and further adjust individual implants. 
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Implant: Bone Graft Simulation 

• Select the implant that requires a bone graft and click the Bone Graft tool . 
• The graft simulation tool appears as an arc that moves along the central axis of the implant in the cross section. 
• Click to place the graft in the desired position. 
• The resulting graft appears in the 2D sections in blue and in the volume rendering in off-white. 
• The volume of the graft is displayed in the volume rendering. 
• The graft can be deleted by clicking on it to select it and pressing the “delete” key on the keyboard. 

 

  

 

 

 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of the imaging, 
there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off scale H.U. The software 
measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement value 
depends on threshold values; thus, user must set proper thresholds to get the best estimate of the desired structure. The 
measurements must not be used as the sole metric for any treatment. 

   

 

Warning: Any measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements 
correctly and employ proper usage of all measurement tools. Measurement accuracy depends on the image data and the 
hardware scanner that generated the image data. The measurement cannot be more precise than the resolution of the image. 
Software reports the value based on user-picked points. Due to the nature of medical imaging, the boundary is not always 
well defined. The apparent boundary depends on the current brightness and contrast setting. The boundary may shift as the 
user makes adjustments to brightness and contrast. The user must understand the limitation of the measurement value before 
applying to the patient. If you notice any inconsistencies or software problems with measurements, or have further questions 
or concerns about using measurement tools correctly, please contact us at (408) 333-3484 or email us at info@Osteoid.com 

  

mailto:info@anatomage.com


 
 

     53 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

Implant: Check Sleeves 

 

The  Check Sleeves function can be performed to determine the position of where sleeves would be if a surgical 
guide was produced for implant placement. This function simulates possible collisions that may occur between: 

• Sleeves and other sleeves 
• Sleeves and the instrument 
• Sleeves and the stone model 
• Instrument and the stone model 

Interference: Demonstrated visually by a dark red-colored sphere. These interference indicators are not updated in 
real-time and are only rechecked after each instance that Check Sleeves is performed.  
 

 
Check Sleeve Interference: The user can 
change certain preferences to better simulate 
the actual procedure that will be performed, 
such as sleeve system, instrument, sleeve size, 
and drill. Solution options are to change 
implant planning, change sleeve preferences, 
or to allow a technician to try to resolve the 
interference. 
  

The option to check sleeves automatically appears when attempting to save Osteoid Surgical Guide planning files. 



 
 

     54 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

Implant: Settings and Preferences 

Selecting the Setting tool  opens up a customization window within the Implant Tab: 

 

Tooth ID System: 

Set the ID to either the Universal or FDI (International) standard. 

Clipping Preference: 

Options for which models to include in volume clipping. 

Show Collision Warning: 

Define whether or not to display a proximity warning between implants at an allowed tolerance. 

Rendering Method: 

Choose the rendering method (Default, Performance, and Quality) to be used in the Implant Tab. 

Color Control: 

Set the various colors for the abutment, restoration, and collision colors. 

Detailed Implant Settings: 

Adjust default settings for individual implants. See more information below. 

Preferred Implants Settings: 

Used to modify which implants are displayed in the drop-down menus in the Control Panel. See more information in 
the Preferred Implant Settings section (pg. 55). 

Update Implant Library: 

Check STL implant library update availability and download them directly.   
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Detailed Implant Settings 
In Detailed Implant Settings, the default settings of each placed implants can be set. 

 

 
Clicking once anywhere in 
the region above activates 
drop-down menus for the 
various implant 
characteristics. Options do 
not appear for implants not 
in the preferred list (see 
below).  

Click OK to save these preferences, and the designated implant will be selected automatically when choosing a tooth in the Add 
Single Implant menu. 
 
Preferred Implants Settings 
The user can hide certain implants from populating the lists to simplify the drop-down menus. By default, all implant 
manufacturers and types are selected as “preferred.” To remove an implant, select it in the list on the right-hand side 
and use the left arrow button to remove it from the list.  

 

These settings apply to the drop-
down menu options for Detailed 
Implant Settings as well as in the 
Implant section of the Control 
Panel. If there is a case open with 
implants that are not in the 
preferred list, the implant will still 
show up correctly in the renderers 
and the Control Panel. However, 
the specific settings for this 
implant cannot be changed and 
implants of the same type cannot 
be added. 

Adding implants to the preferred list can be accomplished by selecting the implant manufacturer on the list on the left-
hand side, selecting the specific product in the middle column, and pushing the right arrow button to add.  

Certain manufacturers are divided into guided and non-guided subsets to indicate compatibility with the Osteoid 
Surgical Guide kits. 
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Update Implant Library 
Due to the size of STL implants, most implant library updates hosted 
online or within the installer do not contain these implants. This 
function allows the user to select specific STL libraries as desired. 
Available updates for the listed manufacturers are indicated in the 
Update column. Select the desired manufacturers and click Update 
to download the library into the software. Restart the software to 
apply the updates. 

 
 

Density Profile Control 

Select the Density Profile Control tool  to adjust the settings for the Density Profile. 
 

 

Visible: Toggles the visibility between the Density Profile and the third 
cross section. 

H.U.: Shows the bone density in Hounsfield units. 

Bone Density: Shows the density in Misch’s bone density units. 

Thickness: Changes the sampled volume located around the implant. 

Apical Space: Changes the sampled volume located at the apex of the 
implant. 

Cell Size: Changes how finely the voxels are sampled and displayed in 
the volume around the implant. 

 

Warning: Any measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of the image. Software reports the value based on user-picked points. Due to the nature of medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of the measurement value before applying to the patient. If you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@Osteoid.com 

mailto:info@anatomage.com


 
 

     57 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If you notice any inconsistencies or software problems with implant planning or 
have further questions or concerns about correct utilization of implant planning, please contact Osteoid support at (408) 333-
3484 or email us at info@Osteoid.com 
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     58 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

 

Gallery View Features 
The Gallery View Tab archives images that have been captured from other tabs. Additionally, images can 
be imported into Invivo or exported to a desired filepath. Comments or notes can be added to describe 
images that have been captured. 
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Gallery: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Gallery View Tab: 

 

 
Crop Image: Crop captured images to save as new images or replace the original. 

 

Gallery: Control Panel 

 

Images: Gives a list of all captured images. 

• Each of these images has a “Name” and “Type” which can be renamed 
by double-clicking on the text. 

• Move Up/Down: Moves the selected image up or down on the list. 
• Crop Current: Crop the currently selected image within Invivo. 
Image Operation 

• All/Selected: Applies operation to all or a subset of the images from the 
list. 

• Remove: Removes images from the Gallery. 
• Export: Export the images in the Image List to a path specified in the 

dialog box that opens or to PACS if configured. Local files can be saved 
as one of the following formats: .jpg, .bmp, or .png. PACS files are stored 
as DICOMs. 

• Email: Email the images in the Image List as attachments from the set 
email account to the recipient’s email address. An email subject line and 
message can be included. 

Import Images: 

• Select to import images (.jpg, .bmp, .png) from an external source into 
the Gallery Tab. 

• Using this, patient photographs or 2D DICOMS can be imported into the 
Invivo software for storage within the Invivo file once saved. 

Comments: 

• Text box displays comments about the image displayed in the rendering window. 
• Add or change comments by editing the text in the Comments Box. 

2D Image Options: 

• Controls settings for 2D images. See more information in Gallery: 2D Image Options. 
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Gallery: Rendering Window 

This window allows the viewing of captured and imported images. The Gallery is particularly useful for creating a workup 
of a particular case. Remember that the Gallery’s images are only saved if the file is resaved; otherwise, any captured 
images will be lost. 

 

 
 
Please refer to Image Navigation (pg. 30) for information about controlling and adjusting these 
images. 
 
  



 
 

     61 of 71                                 

OSTEOID®
  - DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-INVL-ENG-70A ANA003 Rev A. 23 MAR 2023 PAGE 

Gallery: Adding Images to the Gallery 

Capture any single image to the Gallery. A single image within any view can be captured without including the 
other parts of the rendering window. When the Capture to Gallery function is used, a dialog appears on the screen 
providing the user with options regarding which parts of the rendering window to capture.  
 
The options provided by each dialog varies according to which Invivo tab is currently displayed; the following 
example is the dialog that appears within the ArchSection Tab: 
 

 
Ex. ArchSection Capture to Gallery 

Capture to Gallery Dialog: 

• Whole View – Captures a screenshot of the 
rendering window 

• Axial – Captures the axial slice view and no 
other parts of the rendering window 

• Pano – Captures the pano view and no other 
parts of the rendering window 

• Cross Sections – Captures a series of slices 
that are within the rendering window 

 
Options within each Select Image to Capture Dialog: 
Note: Some options appear gray (disabled) in the Select Image to Capture dialog. The choices available are 
determined by the specific layout as well as the view tab. 
 

ArchSection  Whole View 
 Axial 
  

 Pano 
 Cross Sections 

Implant  Whole View 
 Main Volume 
 Axial 
 Cross Section 1 
 Cross Section 2 

 

 Density 
 Pano 
 Arch Volume 
 Front Volume 
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Capture to Gallery Dialog: 

 

 

 Name: Image label 
Note: Image name must be unique from 
any other captured image in the Gallery 
and must not contain any special 
characters. 
 

 Type: Image type – can be set from the 
drop-down to “Captured” or “Photo.” 

  
 Comments: Additional comments about 

the image can be added in this section. 
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Gallery: 2D Image Options 

The Gallery Tab is compatible with 2D DICOM images and has several features that allow it to handle this image format 
better. 

Opening 2D DICOM 

When instructed to open a 2D DICOM image, Invivo automatically enters a mode that disables 3D functionality. 
Only the Gallery Tab is available within the software, and the DICOM appears as a Gallery image. 
 
If a 2D DICOM is associated with a 3D volume as a scout image, opening the volume automatically imports 
that scout image into the Gallery Tab. 
 

 
Grayscale Image Options 
 

For grayscale images in the Gallery, the user has the 
option to adjust several settings such as Gray Scale 
Threshold, Brightness, Contrast, and Sharpening.  
 
The updates to these images are saved and always 
reflect the updated settings when the image is selected 
in the Gallery and also after it has been saved/exported 
and then opened/imported back into Invivo.  
 
 

 

 
Export to DCM/JPG/PNG/TIF/BMP 
 

An image in the Gallery can be exported into any of 
the above formats when using the Export… button. 
When saving individual Gallery images to file, the 
following image formats are available (JPG, PNG, 
BMP).  
 
An image in the Gallery can also be exported to PACS 
as a series.  
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Common How to Tasks 
How to Trace a Nerve 

• Go to the ArchSection Tab. 

• Make sure the pano is in Slice Mode (not X-ray mode). 

• Adjust focal trough such that the nerve pathway is visible in pano image. 

• Move pointer to the pano image. 

• Review the nerve pathway while using scroll wheel.  

• If the nerve pathway is not clearly visible, adjust the focal trough. 

• When the nerve pathway is identified through the pano image, press New Nerve in the Control Panel. 

• Starting from the mandibular foramen, click point by point. 

• If the nerve pathway is not clearly visible, use the mouse scroll wheel to find the nerve pathway and continue 

picking. 

• Near the mental foramen, move the mouse to cross-section view. 

• Use the scroll wheel to find the exit of the nerve. 

• Pick points connecting the nerve exit. 

• Press Done in the Control Panel to finish the nerve. 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if diagnosis, treatment plans and/or actual treatment is based off of the incorrect tracing. It is critical for 
the end user to learn how to properly perform nerve tracings correctly. If you notice any inconsistencies or software 
problems with nerve tracing or have further questions or concerns about nerve tracing, please contact Osteoid support 
at (408) 333-3484 or email us at info@Osteoid.com 
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How to Create Reports in Life Size 

• Go to ArchSection Tab. 

• Select Reorientation button in the toolbar 

• Adjust upper and lower limit by dragging green lines and then click Reorientation button to exit. 

• Adjust focal trough (arch spline) or re-draw arch spline by the clicking the Create Arch Spline button. 

• Change Layout Mode to “Print Out.” 

• Change to a desired layout using the Change Layout button. 

• Adjust cross-sectional width and interval. 

• Move cursor to set cross section in desired location. 

• In Print Out mode, user cannot zoom the image since it is set to life size. 

• If desired structure is not visible in cross section, adjust axial cursor or focal trough. 

• Switch pano image to X-ray mode and turn on the ruler. 

• Turn on the Arch Spline Ruler and turn off arch spline control points. 

• Turn off the cursor if necessary by clicking Toggle Cursor Visibility. 

• Go to the View menu and choose “Capture to Gallery” or press Ctrl + G 

• Go to Gallery Tab. 

• See Print Preview in the File menu and print out a test page. 

• To change the format, go to “Print Layout Setup” in the File Menu. 

• To use a personal logo, replace the “printLogo.bmp” file in installation folder. This folder is typically in 

“C:\Program Files\Anatomage\InvivoLite” 

• If the Print Layout Setup is changed, choose Print Out mode before recapturing the image. Otherwise the image 

could still be in the previous Print Layout Setup. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of the image. Software reports the value based on user-picked points. Due to the nature of medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of the measurement value before applying to the patient. If you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at info@Osteoid.com 

  

mailto:info@anatomage.com
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Invivo7 Software Troubleshooting 

Category Error Solution 

General Error Message: 
InvivoLite Application has encountered a problem and needs to close. We 
are sorry for the inconvenience. 
 

 Click the “Don't Send” button. 
 Check if there are old versions of optional plug-ins: remove 

them or upgrade them to be compatible with InvivoLite. 
 Launch the InvivoLite application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Cannot launch InvivoLite  Open Task Manager and check if multiple instances of 
InvivoLite are already running. 

 Close other InvivoLite processes. 
 Launch the InvivoLite application again. 

Computer failure Launch the InvivoLite application again. 
Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Installation Error Message: 
Server is not Responding 

 Check Internet connection. 
 If Internet is connected, try again later. 

Error Message: 
Please run as administrator to activate software 

Run the installer/application as administrator. 

Error Message: 
Administrative access is required to update the application. If you are an 
administrator, please relaunch the software by right-clicking on the 
application Icon and select-ing “Run as Administrator” 

Run the application as an administrator to update the software 
using Auto-Update 

Error Message: 
To check for updates please connect to the internet 

To check for updates, please connect to the internet 

Error Message: 
You must be signed in to your Invivo Work-space account to download a 
software update 

To download updates, please connect to the internet 

Error Message: 
Failed to verify the license code! 

Check the license code and try again. 
Check Internet connection and try again. 

Error Message: 
Wrong License Code! 

Check the license code and try again. 

Error Message: 
Invalid Authorization code 

Check the license code and try again. 

Error Message: 
Actual size of the image can't fit to the paper size! 

Change printer setting or create an image with smaller size. 
 

Licensing Error Message: 
Number of allowed activation's exceeded. Please logout of any other 
sessions. For help please contact your administrator, or contact support 
for help by phone (408) 333-3484 or email Support@osteoidinc.com 

You can only have Invivo opened on a certain amount of 
computers at the same time, depending on the number of 
licenses you have. (Example: If you have 3 licenses, you have 
Invivo open up to 3 computers at the same time). Deactivate 
licenses by signing out of an Invivo instance, or by managing 
your licenses in Invivo Workspace. 

Error Message: 
There is no valid license code associated to this Invivo Workspace 
account. Please login with another account, contact your administrator, 
or contact support for help by phone (408) 333-3484 or email Sup-
port@osteoidinc.com. 

The account you logged in with does not have a license of 
Invivo. Please check you are using the correct login or contact 
Support. 

Error Message: 
Invivo requires access to the internet to activate the software. Please 
contact support for help by phone (408) 333-3484 or email 
Support@osteoidinc.com 

You must be connected to the internet to license Invivo. 

mailto:Support@osteoidinc.com
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Or  
Please connect to the internet to Sign out of your Invivo WORKSPACE 
Account 

Error Message: 
Invivo requires access to the internet to function properly. Please connect 
to the internet within XX hours or the software will be disabled. If you 
cannot reconnect to the internet within the allotted time please con-tact 
support for help by phone (408) 333-3484 or email 
Support@osteoidinc.com 

Invivo requires a constant connection to the internet. Once 
disconnected, you have until the allotted time in the error 
message to reconnect before you can no longer use Invivo 
during this session. 

Error Message: 
Your License has been remotely deactivated from this machine 

This occurs if you have deactivated your license remotely using 
Invivo Workspace, or if you logged into Invivo on another 
computer with an Invivo One plan. This may also occur if you 
signed out of an instance of Invivo on your computer, but still 
have another instance open. 

File Operations Error Message: 
Failed to create process. Please close other applications and try again. 

 Close all the other applications. 
 Launch the InvivoLite application again. 

Error Message: 
Error: Unknown file format! 

Check if this file is supported by InvivoLite. 

Error Message: 
Not enough memory 

 Close all the other applications. 
 Launch the InvivoLite application again. 

Error Message: 
Can't create temporary save file! 

Check if the remaining disk capacity for the temporary folder 
is big enough. 

Error Message: 
Failed to read DICOM file! 

Check if this file is supported by InvivoLite. 

Error Message: 
Can't read Dicom’s Image Data! 

Check if this file is supported by InvivoLite. 

Try to open a file but nothing showing up Check if this file is supported by InvivoLite. 

Error Message: 
Cannot save file! 

 Check if the file is the correct type. 
Check if the file path is correct and folder is writable. 

Image is distorted  Switch to another view and switch back. 

Warning Message: 
3D reconstruction may not work! 

 Check if the DICOM files are exported correctly. 

 
For all other issues, please contact Osteoid Inc. Customer Support at (408) 333-3484. 
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Keyboard Shortcuts 
The following keyboard shortcuts are available:  

 Hotkey Description 

ArchSection Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Up Arrow/Down Arrow Scrolls through selected slice 

 Delete Deletes the selected 
measurement/notation/nerve 

Implant 0 Changes to Volume preset 

 1 Changes to Implant preset 

 2 Changes to Stone Models preset 

 3 Changes to Restoration preset 

 4 Changes to Restoration2 preset 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 H Volume is clipped along the arch 

 F Volume clipping is flipped 

 Delete Deletes the selected 
measurement/implant/airway 
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Index 
This comprehensive list provides a quick and easy way to find the relevant information as desired. 

 
Apical Space ............................................................................................................................................. 56 
Arch Section View Tab ............................................................................................................................. 34 
Arch Spline ................................................................................................................................... 35, 39, 51 
Bone Density ............................................................................................................................................. 56 
Bone Graft ........................................................................................................................................... 43, 52 
Brightness & Contrast ......................................................................................................................... 37, 45 
Case Information ....................................................................................................................................... 28 
Check Sleeves ..................................................................................................................................... 43, 53 
Clipping..................................................................................................................................................... 46 
Color Presets ....................................................................................................................................... 37, 45 
Comments ..................................................................................................................................... 43, 59, 62 
Control Panel .......................................................................................................................... 16, 37, 45, 59 
Density Profile .............................................................................................................................. 43, 47, 56 
DICOM ......................................................................................................................................... 21, 23, 63 
DICOM & Invivo File Loading ................................................................................................................ 21 
Export Image ............................................................................................................................................. 63 
Gallery View Tab ...................................................................................................................................... 58 
Grid ........................................................................................................................................................... 44 
Image Capture ..................................................................................................................................... 28, 29 
Implant ................................................................................................................................................ 43, 46 
Implant Angles .......................................................................................................................................... 43 
Implant Summary...................................................................................................................................... 44 
Implant Types ...................................................................................................................................... 46, 55 
Implant View Tab ...................................................................................................................................... 42 
Import Image ............................................................................................................................................. 59 
Invivo File Saving ..................................................................................................................................... 23 
Keyboard Shortcuts ................................................................................................................................... 68 
Layout ........................................................................................................................................... 35, 44, 47 
License types ............................................................................................................................................... 9 
Life Size .............................................................................................................................................. 37, 65 
Measurements ..................................................................................................................................... 35, 43 
Menu Bar .................................................................................................................................................. 16 
Misch’s bone density units ........................................................................................................................ 56 
Mouse Navigation Tools ......................................................................................................... 30, 39, 47, 49 
Move Widget ............................................................................................................................................. 43 
Nerve ................................................................................................................................. 37, 40, 41, 48, 64 
Panoramics .......................................................................................................................................... 39, 51 
Patient Info .......................................................................................................................................... 35, 44 
Patient Orientation .................................................................................................................................... 37 
Rendering Window ................................................................................................................................... 16 
Reset Zoom ......................................................................................................................................... 35, 43 
Software Layout ........................................................................................................................................ 16 
Stone Model .............................................................................................................................................. 49 
Toolbar .................................................................................................................................... 16, 35, 43, 59 
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Tru-Pan ...................................................................................................................................................... 37 
View Sequence .................................................................................................................................... 35, 44 
View Settings ............................................................................................................................................ 18 
View Tabs .................................................................................................................................................. 16 
Waxups ................................................................................................................................................ 48, 49 
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